Managing Files and Folders

File management is organizing and keeping track of files and
folders, helping you stay organized, so information is easily
located. A folder is a container for storing programs and files,
similar to a folder in a file cabinet. As with a file cabinet,
working with poorly managed files is like looking for a needle
in a haystack—it is frustrating and time-consuming to search
through irrelevant, misnamed, and out-of-date files to find
the one you want. Windows Vista allows you to organize fold-
ers and files in a file hierarchy, imitating the way you store
paper documents in real folders. Just as a file cabinet con-
tains several folders, each containing related documents with
dividers grouping related folders together, so the Windows
file hierarchy allows you to organize your files in folders, and
then place folders in other folders. At the top of each hierar-
chy is the name of the hard drive or main folder. This drive or
folder contains several files and folders, and each folder con-
tains related files and folders.

Using the file management tools, you can save files in
folders with appropriate names for easy identification,
quickly and easily create new folders so you can reorganize
information and delete files and folders that you no longer
need.You can also search for a file when you cannot remem-
ber where you stored it, create shortcuts to files and folders
for quick and easy access, and even compress files and fold-
ers to save space.

A folder can hold different types of files, such as text,
spreadsheets, and presentations. The Documents folder is the
main location in Windows Vista where you store your files.
However, there are some special folders, such as Pictures and
Music, designed with specialized features to store specific
types of files.

Use the Explorer Window

Change the Explorer Window View
Open and View the Computer

View and Open Documents

Navigate Between Folders

View the Folders List

Customize the Navigation Pane
Organize Files by Headings

Search for Files and Folders

Perform an Instant Search

Add Properties and Tags to Files
Create and Rename Files and Folders
Copy and Move Files and Folders
Delete and Restore Files and Folders
Create a Shortcut to a File or Folder
Change Folder Options

Change File and Folder List Views
Customize Personal Folders

Share Files or Folders with Others
Compress Files and Folders

Manage Files Using a CD or DVD
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Using the Explorer Window

The Explorer windows (New!) are powerful
easy-to-use tools for working with files con-
sistently across Windows Vista. Explorers give
you more information and control while sim-
plifying how you work with your files. The
experience is easy and consistent, whether
you're browsing documents or photos or
even using the Control Panel. Key elements of
the Explorer windows in Windows Vista are
designed to help you get to the information
you need, when you need it. Each Explorer
window includes the following elements:

Back and Forward buttons. Use to
navigate between previously viewed
folders.

Address bar. Use to navigate directly to a
different location, including local and
network disks, folders, and Web
locations.

Search box. Use to perform instant
searches, which show only those files

Back and Forward buttons

that match what you typed in the Search
box for the current folder and any of its
subfolders.

Toolbar/Command bar. Use to perform
file related commands. Toolbar/Command
bars display only the task buttons that
are appropriate for the files being
displayed. There are two consistent
buttons on every Toolbar/ Command bar:
Organize and Views.

Navigation pane. Use to display common
folders, such as Documents, Pictures,
Music, the Folders list, and other favorite
links, such as recently changed files,
saved searches, and public folders.

Folders list. Use to access additional
folders using a folder tree structure
similar to the previous version of
Windows. To open or close the Folders
list, click Folders at the bottom of the
Navigation pane.
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Changing the Explorer Window View

Windows Vista displays the contents of a
drive or folder in different ways to help you
find the information you are looking for about
a file or folder. The available views include
Extra Large, Large, Medium and Small Icons
(New!), List, Details, andTiles.

Icons view displays icons in different sizes
(Extra Large, Large, Medium, and Small),
sorted alphabetically in horizontal rows, with
the name of the file or folder below each icon.
When you view files using one of the Icon
views, Live icons (New!)—thumbnails—dis-
play the first page of documents, the image of
a photo, or the album art for individual songs,
making it easier to find exactly what you are
looking for.

List view displays small icons, sorted alpha-

betically into vertical columns, with the name
of the file or folder next to each icon.

Views button

Details view displays small icons, sorted
alphabetically in a single vertical column, with
the name of the file or folder and additional
information, such as file size, type, and date,
in columns to the right.

Tiles view displays icons, sorted alphabeti-
cally into vertical columns, with information
about the file next to each icon.

Switching Between Views

You use the Views button on the toolbar in an
Explorer window to quickly switch between
window views. When you click the Views but-
ton, the view switches between the following
four views: List, Details, Tiles, and Large
Icons. If you want to select a different view,
you can click the arrow next to the Views but-
ton to display a menu, where you can click a
view or drag the slider. When you drag the
slider, you can position it anywhere within the
range, not just the main positions.
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Opening and Viewing
the Computer

Open and View the Computer

Click the Start button, and then
click Computer.

Click a drive to select it.

Review the drive details in the
Details pane.

Double-click the drive to open it.

Click the Back button or Forward
button on the toolbar to return or
move to a previously visited
window.

TIMESAVER You can press the
Backspace key to go back to a
previous folder you visited.

When you're done, click the Close
button.

56

The Computer window is the starting point to access every disk, folder,
and file on your computer. You can access the Computer window from
the Start menu. The Computer window displays several types of local,
removable, and network drives. Drives and folders are represented by
icons. Each drive is assigned a drive letter, denoted with parentheses
and a colon, such as Local Disk (C:), to make it easier to identify.
Typically, the floppy is drive A, the hard (also known as local) disk is
drive C, and the CD or DVD is drive D. If your computer includes addi-
tional drives, your computer assigns them letters in alphabetical order.
Once you open more than one drive or folder, you can use buttons on
the Command bar to help you move quickly between folders.
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You can add the Computer icon to the
desktop. Right-click the desktop in a
blank area, click Personalize, click
Change desktop icons in the left pane,
select the Computer check box, and
then click OK.

You can find Windows system infor-
mation in Computer. Click the Start
button, click Computer, click System
properties on the toolbar.

You can find drive or device proper-
ties in Computer. Click the Start button,
click Computer, click the drive or
device, click Properties on the toolbar,
and then click the General tab.

See Also

See “Changing the Explorer Window
View” on page 55 for information on
changing the display of a folder’s
contents.

Typical Disk Drives on a Computer

Icon

Type Description

Local

A hard magnetic disk (or hard disk) on which you can store
large amounts of data. The Local Disk (C:) stores all the files
on your computer.

Floppy

A soft removable magnetic disk that comes in a 3/2-inch
size, which stores up to 1.44 MB of data. Floppy disks are
slower to access than a hard disk, but are portable and
much less expensive.

Removable

A removable magnetic disk on which you can store
computer data, such as a Zip disk (requires software).
Another is a Flash memory card the size of a large stamp
that holds128, 256, 512 MB or greater. Flash drives connect
directly into a USB plug without software.

CD-ROM

Compact Disc-Read-Only Memory An optical

disk on which you can stamp, or burn, up to 1 GB (typical
size is 650 MB) of data in only one session. The disc

cannot be erased or burned again with additional new data.

CD-R

Compact Disc-Recordable A type of CD-ROM

on which you can burn up to 1 GB of data in multiple
sessions. The disc can be burned again with new data,
but cannot be erased.

CD-RW

Compact Disc-Rewriteable A type of CD-ROM on which
you can read, write, and erase data, just like a hard disk.

DVD

Digital Video Disc A type of DVD-ROM that holds a
minimum of 4.7 GB, enough for a full-length movie.

DVD-R

Digital Video Disc-Recordable A type of DVD-ROM on
which you can burn up to 4.7 GB of data in multiple
sessions. The disc can be burned again with new data, but
cannot be erased.

DVD-RW

Digital Video Disc-Rewriteable A type of DVD-ROM on
which you can read, write, and erase data, just like a hard
disk.

Chapter3 Managing Files and Folders
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Viewing and Opening
Documents

View and Open Documents

Click the Start button, and then
click Documents.

Click a file to select it.

Review the document details in
the Details pane.

Double-click the file to open it.

Use the scroll bars to view
additional documents. Drag the
scroll box, or click the scroll
arrows.

When you're done, click the Close
button.

Windows creates a separate
Documents folder for each user.

When you share a computer, Windows
creates a separate Documents folder
and stores personalized settings for
each user. Each user's Documents
folder is located in the Documents And
Settings folder under the user’s name
on the local hard disk.
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Windows makes it easy to manage the personal and business files and
folders you work with every day. You can access your Documents
folder from the Start menu. In the Documents folder, you can view file
information, organize files and folders, and open files and folders. Once
you open more than one folder, you can use buttons on the Command
bar to help you move quickly between folders. Depending on previous
installation, devices installed, or other users, your personal folders

might differ.
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Open Any Folder and Switch
Between Folders

Click the Start button, and then
click the user account name, or
any other Explorer window, such

as Documents, Pictures, or Music.

Double-click the folder to open it.

Click the Back button or Forward
button to return or move to a
previously visited window.

When you're done, click the Close
button.

Windows stores music and picture
files in separate folders in your
personal folder. Windows stores
music files in the Music folder and pic-
tures in the Pictures folder, which you
can access from the Start menu.

See Also

See “Changing the Explorer Window
View" on page 55 for information on
changing the display of a folder’s
contents.
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Opening a Document with a Different Program

Most documents on your desktop are associated with a specific pro-
gram. For example, if you double-click a document whose file name
ends with the three-letter extension “.txt,” Windows automatically
opens the document with Notepad, a text-only editor. There are situ-
ations, though, when you need to open a document with a program
other than the one Windows chooses, or when you want to choose a
different default program. For example, you might want to open a text
document in WordPad rather than Notepad so that you can add for-
matting and graphics. To do this, right-click the document icon you
want to open, point to Open With, and then click the application you
want to use to open the document, or click Choose Program to
access more program options. Once you open a text file using
WordPad, this option is automatically added to the Open With menu.

Chapter3 Managing Files and Folders
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Opening Recently
Used Documents

Open a Recently Used
Documents

Click the Start button, and then
point to Recent Items.

Click the file you want to open
from the submenu.

The program associated with the
file starts and opens the file.

When you're done, click the Close
button.

Open a Recently Changed File

Click the Start button, and then
open an Explorer window, such as
Username, Documents, Pictures,
or Music.

Click the Recently Changed link.

To open a file, double-click the file
icon.

The program associated with the
file starts and opens the file.

When you're done, click the Close
button.
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Windows Vista makes it easy to find and open recently used files. You
can use the Recent ltems option on the Start menu, or the Recently
Changed folder (New!) in the Navigation pane of an Explorer window.
To quickly open a recently used file, click the Start menu, point to
Recent Items, and then click the file you want to open. To view recently
changed files, open an Explorer window, such as Documents, and then
click Recently Changed in the Navigation pane. If you want to open a
file, simply double-click it.
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Working with
Personal Folders

View and Open a Personal
Folder

Click the Start button, and then
click the user account name at the
top of the right column on the Start
menu.

Double-click a folder to open it.

When you're done, click the Close
button.

Windows Vista comes with a personal folder that store your most fre-

quently used folders in one location. The personal folder appears on

the Start menu with the name of the person logged on to the computer.

The personal folder only contains files and folder associated with a
user account and are unique for each user on the computer. The per-
sonal folder (New!) includes a variety of folders: Contacts, Desktop,

Documents, Favorites, Links, Music, Pictures, Saved Games, Searches,
and Videos. You can access these folders using the personal folder or

by name on the Start menu.
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Navigating Between

Folders

Navigate to a Location
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Click a location. Use either of the
following methods:

Visible folder location. To go
directly to a location visible in
the Address bar, click the
location name.

Visible subfolder location. To
go to a subfolder of a location
visible in the Address bar, click
the arrow to the right, and then
click the location name.

Type a location. Click a blank
space (to the right of text) in the
Address bar, and then type the
complete folder name or path to
the location, and then press Enter.

You can type common locations
and then press Enter. The common
locations include: Computer,
Contacts, Control Panel,
Documents, Favorites, Games,
Music, Pictures, Recycle Bin, and
Videos.

If you type a Web address (URL) in
the Address bar, the Explorer
window switches to Internet
Explorer.

The Address bar (New!) appears at the top of every Explorer window
and displays the current location on your computer or network. The
location appears as a series of links separated by arrows. You can
change your current location by either typing a new location—even a
Web address on the Internet—or selecting one using the Address bar.
You can also use the Back and Forward buttons to the left of the
Address bar to switch between locations you have previously visited.

Address bar Click a location
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: H Windows Vista offers a useful feature for managing files and folders,
VIEWI“g the called the Folders list. The Folders list displays the window in two
Folders |_|st panes, or frames, which allows you to view information from two differ-

ent locations. The left pane of the Folders list displays the file hierarchy
of all the drives and folders on the computer, and the right pane dis-
plays the contents of the selected drive or folder. This arrangement
enables you to view the file hierarchy of your computer and the con-
tents of a folder simultaneously making it easy to copy, move, delete,
and rename files and folders. Using the non filled arrow and the filled
arrow to the left of an icon in the Folders list allows you to display dif-
ferent levels of the drives and folders on your computer without open-
ing and displaying the contents of each folder.

View the Folders List
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Folders list.

a [E| Documents
Perform the commands you want =
to display folder structure and 1
contents: ¥enies) =

l 4 items

To show the file and folder
structure, click the non filled

o © 0O

To hide the file and folder
structure, click the filled arrow.

To display the contents of a
folder, click the folder icon.

In the Navigation pane, click the
Folders link again to close the
Folders list.

You can quickly determine if a folder
contains folders. When an arrow
doesn't appear next to an icon in the
Folders list, the item has no folders

in it.
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Changing the Explorer Windows Vista gives you the option to customize the layout for each

Explorer window depending on the information the window contains.
Layout The layout (New!) for each Explorer window includes a Menu Bar,
Details pane, Preview pane, and Navigation pane. The Details and
Microsoft Navigation panes appear by default. Some Explorer windows, such as
o WINV-4.1.4 the personal folder labeled with your user account name, also include
a Search Pane, which you can use. The Organize menu shows or hides
the layout elements. If you prefer working with menus like the previous
version of Windows, you can show the Menu Bar and use traditional

menus.
Change the Explorer Layout
Open the folder window you want e
to change.
(E=3Ee8 5|
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Layout options vary depending on = e e e
the type of Explorer window. s T J

Properties
TIMESAVER To quickly display Cose
the Menu bar, press the Alt key, Fakizs 2
and then release it. Press the Alt e
key again to remove it.
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Customizing the
Navigation Pane

Micr_o_soft
Certified WINV-4.2.4

Application
Specialist

Customize the Navigation Pane

Move a link. Drag an item in the
Navigation pane to a higher or
lower position.

Add a link. Drag an item from its
original location to a position on
the Navigation pane. This includes
folders from the Folder list at the
bottom of the Navigation pane.

Rename a link. Right-click the

item, and then click Rename. Type
a new name, and then press Enter.
The original folder or search is not
renamed, only the Navigation link.

Remove a link. Right-click the
item, and then click Remove Link.
The original folder or search is not
removed, only the Navigation link.

Restore default links. Right-click a
blank area of the Navigation pane,
and then click Restore Default
Favorite Links.

The Navigation pane (New!) provides links to commonly used folders
and saved searches to reduce the number of clicks it takes to locate a
file or folder. Windows Vista provides a default list of favorite links
including Documents, Pictures, Music, Recently Changed, and
Searches. You can customize the Navigation pane to include the
folders or saved searches you want for your everyday use. You can
move current links, add or rename folders or save searches, or remove
an item. If the Navigation pane gets cluttered, you can restore it back
to the original default items and start from there.

(=S
@Uv‘![\ » Steve » Documents » [ 42 ][ search 2|
Wy Organize ~ 58 Views ~ LM Open M5 E-mail fw Share
Favorite Links Name Datemodified  Type Size Tags
B Documents | L
B Pictures §ll b ! \
Music Business  Projects  Home Sense

i
(& Recently Changed
B Searches

Public

# Createlink in Links

olders ~

Projects
File Folder

| Date modified: 11/28/2004 3:34 AM

Navigation pane Move a link

(E=3 =8 =)
@"’u‘.mg b eEn b e b [ [ scarch o
Wy Organize ~ 88 = [ Open B E-mail |y Share
Favorite Links Name Datemodified  Type size Tags
Projects Il
B Documents Open
B Pictures Open folder location o
B Music i
& Recently Cha B
B scorches Add to Windows Media Player list
Fa Play with Windows Media Player
@ Snaglt »
Restore previous versiens
Send To v

Cut
Copy

Create Shortcut

Remove Link

Rename
Folders
Sort by Name
Pr Y
B File Properties

} Date modified: 11/28/2006 3:34 AM

Rename a link Remove a link

Chapter3  Managing Files and Folders 65



Organizing Files by
Headings

Microsoft

Certified WINV-4.5.3, WINV-4.5.4,
Application | WINV-4.5.5

Specialist

Organize Files Using Filtering

Open the folder that contains the
files you want to filter.

Point to the heading you want to
filter by.

Click the arrow to the right of the
heading you want to filter by.

Select the property check boxes
you want to filter by.

Click in a blank area to close the
search menu.

To cancel the search, press
Esc.

You can sort files using headings.
Open the folder that contains the files
you want to sort, point to the heading
you want to sort by, click the arrow to
the right, and then click Sort. Click in a
blank area to close the search menu.
To quickly sort files by headings, click
the heading title. Either method, the
sort toggles between ascending and
descending.

66

In Explorer windows, files appear in lists with headings at the top. You
can use the headings to change how files are displayed in the window.
There are several ways to organize your files by using file list headings
and they include filtering, stacking, and grouping. Filtering (New!) dis-
plays only files with the properties you select by heading type. Stacking
(New!) displays all of the files in the view into piles by heading type.
After you stack files into piles, you can open individual ones to view the
contents of the stack. Grouping (New!) displays a sequential list of all
of the files by heading type. Grouping and stacking are similar organi-
zational tools. Grouping organizes files into visible groups, while
stacking organizes files into hidden groups within an icon.
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Organize Files Using Stacking

Open the folder that contains the
files you want to stack.

Point to the heading you want to
stack by.

Click the arrow to the right of the
heading you want to stack by.

Click Stack by <heading name>.

Click in a blank area to close the
search menu.

To cancel the search, press
Esc.

To view the files within an
individual stack, double-click the
stack.

Organize Files Using Grouping

Open the folder that contains the
files you want to group.

Point to the heading you want to
group by.

Click the arrow to the right of the
heading you want to group by.

Click Group.

Click in a blank area to close the
search menu.

To cancel the search, press
Esc.
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Searching for Files
and Folders

Microsoft
Certified WINV-4.4.5,

Application | WINV-4.4.6
Specialist

Create a Simple Search by Type

Click the Start button, and then
click Search.

Click the type of file you want to
locate: All, E-mail, Document,
Picture, Music, or Other.

To search for folders, click All.
Click in the Search box.
Type a word or part of a word.

As you type, programs and files
that match your text appear on the
Start menu. You don’t have to
press Enter.

TROUBLE? /n the Search box,
you must press Enter to start a
search for files in non-indexed
locations.

You can search everywhere on your
computer. If you can't find a file, you
can search everywhere on your com-
puter. In the Advanced Search pane,
specify any search criteria, click the
Locations arrow, click Everywhere,
and then click Search. This might take
a long time.
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Sometimes remembering precisely where you stored a file can be
difficult. Windows provides a Search folder (New!) to help you find
and view all of your files or folders in one place. The Search folder pro-
vides easy access to all of your most common files, such as docu-
ments, pictures, music, and e-mail, in a single view. If you don't find the
file or folders you're looking for, you can perform an advanced search.
An advanced search gives you the option to find files or folders by type,
name, title, location, date (taken, modified, or created), size, or property
tag. The search locates files and programs stored anywhere in indexed
locations, which includes personal folders, e-mail, offline files, and
Web sites in the History list for your Web browser. The Search folder is
accessible from the Start menu (or any folder window) to help you
locate files and folders.

elEEs
O@-\j“ » Search Results <[4 o]
[show only: [All] E-mail  Document  Picture  Music  Other | Advanced Search ()|

To begin, type in the search box

To search more of your computer, use Advanced Search.

Favorite Links Folder Authors  Tags B
[l Documents Horme Sense H
B pictures I File Folder
B Music i i
& Recently Changed 4 File Folder  mmmmy
B searches g
i StoreFAQs
[l | File Folder
F
) Projects
£ } Filk Folder
Search
Home Sense Logo
L. FileFolder results
Home Sense
i L Filk Folder
|| Procedures
£ } Filk Folder
i Letters
Folders ~ g L File Folder 2
£ 235 ftems




Create an Advanced Search o

Click the Start button, and then

. ElolE
C“Ck searCh' C@v\ » Search Results ~ 44 A
Click the type of file you want to Ishowomy Emeil Document Picture  Music Other] Advan:edieav:h“{+—o
|Ocate A", E'mail, Document, To begin, type in the search box
Picture, Music, or Other. Tosearch ore of o compn SRR
Click the Advanced Search button.
Specify the search options you
want:
Name. Type a file name.
Tags. Type a property tag.
. =]
Title. Type the author name. =[5 » sewch vt <[4 [ e 2]
. X . [showonly: Al Evmail  Document Music  Other Advanced Search (4|
Location. Click the list arrow, Locaon | s e o]

and then select a search s o
8 Size (KB) Title Add atitle

location.

[]Include non-indexed, hidden, and system files (might be slow)

Date. Click the first list arrow,
select the date type you want
to find, click the second list
arrow, select a search criteria,
and then specify a value.

To begin, type in the search box

To search more of your computer, use Advanced Search.

Size. Click the list arrow, select
a search criteria, and then o o
specify a value.

Select or clear the Include non-
indexed, hidden, and system files

(might be slow) check box. e
@C-U » Search Results in Indexed Locations » Picture ~ [ 4| nametLoge x |
1 Show only: All E-mail Document [ Picture | Music  Other Advanced Search( ~)
IC earch. (Bicture =
Location [/ Indexed Locations ~ Name Logo

Size (KE) Tile Add a title
[FInclude non-indexed, hidden, and system files (might be slow)

rch @ Search Toole =

Favre ks Name Datetaken  Folder Tags Size Rating

E) Documents

B Pictures ft ‘z
@ Recently Changed Perspection e MOMESENSE | WOMESEN MOMESEN Results
!B Searches Fnl_Logo HS Logo Color HS Loge Color HS Logo Color HS Loge Color
Public Brand Small
Folders - a
H 20 items
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Saving a Search

Microsoft

Certified WINV4.4.2

Application
Specialist

Save a Search

Click the Start button, and then
click Search.

Specify the criteria you want, and
then perform the search.

Click the Save Search button on
the toolbar.

Type a name for the search.
Click Save.

To use a saved search, click the
Searches link in the Favorite Links
pane, and then double-click the
saved search.

10

If you frequently perform the same search, you can save your search
results (New!) like any file and perform or modify the search again
later. When you save a search, the search is saved by default in the
Searches folder, which you can open by clicking the Searches folder
link in the Navigation pane. Like any link, you can move a saved search
from the Searches folder to the Favorite links section in the Navigation
pane to make it more accessible. To run a saved search, display the
saved search link, and then double-click it.

18]

=lEEs

[+ Search Results in Indded Locations » Picture

<o [nameLogo ~]

[ show onl

Favorite |

[ Docu
B Ppictur
B Musid

Al

| E-mail

ks
ents.

3

& Recen

ly Changed

B searches

Public

Document Music  Other

 Search Tools +

Name Datetaken  Folder

ﬁt 4

Perspection

Fnl_Logo HS Logo Color
Brand

HOME £ wWomEsew HOME

HS Logo Color

Folders ~

)

Advanced Search ()|

Tags Size Rating E

m

HS Logo Color  HS Logo Color

small

|l Save As

OO ‘ » Steve » Searches »

-

+5 | ‘ Search o

File name: Logos ==

Save as type: [Search Folder

Authors: Steve

¥ Browse Folders

Tags: Add atag




Changing Search
Options

Microsoft
Certified | wiNv-4.4.1

Application
Specialist

Change Search Options

Click the Start button, and then
click Search.

Click the Organize button on the
toolbar, and then click Folder and
Search Options.

TIMESAVER After a search,
click Search Tools on the toolbar,
and then click Search Options.

Click the Search tab.

Select the What to search option
you want.

Select or clear the check boxes
under How to search:

Include subfolders when typing
in the Search box.

Find partial matches.
Use natural language search.

Don’t use the Index when
searching the file system
(might be slow).

Select or clear the check boxes
under When searching non-
indexed locations:

Include system directories.

Include compressed files (ZIP,
CAB, ...

Click OK.

When you perform a search for files or folders, Windows Vista uses the
search options (New!) to help customize the search results. You can
specify whether you want to search for file names and content or just
for file names and whether to include subfolders or find partial
matches. For non-indexed searches, you can set options to include sys-
tem directories or compressed files (ZIP, CAB...). The search options
are available in the Folder Options dialog box under the Search tab.

Folder Options ==

General | View Saarm

What to search =

@ Inindexed locations, search filenames and contents
In non-indexed locations, search file names only.

7 Ahways ssarch fils names and conterts (might be slow)
() Aways search file names only

How to search
Include subfolders when typing in the Search box
Find partial matches
[T Use natural language search

] Dont use the Index when searching the file system fright
be slow)

When searching nonindexed locations =]
[ Include system directories
[[] Include compressed files (ZIP, CAB..)
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Performing an Instant
Search

WINV-4.4.3,
WINV-4.4.4

Find a File or Program Using the
Search Box on the Start Menu

Click the Start button.
Click in the Search box.
Type a word or part of a word.

As you type, programs and files
that match your text appear on the
Start menu. You don’t have to
press Enter.

TROUBLE? In the Search box,
you must press Enter to start a
search for files in non-indexed
locations.

You can display search properties.
Right-click the heading in an Explorer
window that you want to see
properties for, and then click More.

12

You can also find files and programs using the Search box at the
bottom of the Start menu and at the top of every Explorer window. The
Search box (New!) filters out items that don't match the text you type.
The search includes text in the file name, text in the file, tags (a custom
file property), and other file properties. The search locates files and
programs stored anywhere in indexed locations, which includes
personal folders, e-mail, offline files, and Web sites in the History list
for your Web browser.




Find a File or Folder Using the
Search Box From a Folder

Click the Start button, and then
open the Explorer window where
you want to start looking, such as
Documents, Pictures, or Music.

Click in the Search box.
Type a word or part of a word.

As you type, programs and files
that match your text appear on the
Start menu. You don’t have to
press Enter.

TROUBLE? /nthe Search box,
you must press Enter to start a
search for files in non-indexed
locations.

You can use wildcards to expand a
search. Use the * (asterisk) wildcard
symbol in a file name when you're
unsure of the entire name. For exam-
ple, type S*rs to find all files beginning
with “S” and ending with “rs,” such as
Stars and Sports cars.

Faverite Links

B Documents Ml
| 4 ~ 4 o
Pict | j = e = || -
g s | | | H | = —H: Results
Music s i ’ ¥
Projects Letters Business Home Sense  Employees é;f' Organized

(5 Recently Changed
IB Searches

Public

Folders ~

an 280 items
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Performing an
Advanced Search

Find Files and Folders Using
the Search Folder

Turn off natural language search.
(default off).

Click the Start button, click
Control Panel, double-click the
Folder Options icon in Classic
view, click the Search tab,
clear the Use natural language
search check box, and then
click OK.

Click in the Search box at the
bottom of the Start menu or at the
top of an Explorer window.

Type an advanced search. See the
table for some examples.
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The Search box (New!) at the bottom of the Start menu and at the top
of every Explorer window filters out items that don't match the text you
type. The search includes text in the file name, text in the file, tags

(a custom file property), and other file properties. In the Search box,
you can perform advanced searches by specifying properties and using
boolean filters. For example, Name:Agenda finds only files that have the
word agenda in the file name. In addition, you can use boolean filters,
such as AND, NOT, OR, Quotes, Parentheses, >, or <. For example,
Agenda AND Reportfind files that contain both words agenda and
report. When you type boolean filters, you need to use all capital let-
ters. You can also combine properties and boolean filters together to
create a more specific search.

(E=8 o =]
.
@u-\d » s ] [Home AND Logo —L—e
Orc earch ) Search Toals ~ @
Favorite Links Typ Fold: Auth Tags
IE/ Documents |
B Pictures } & (‘
B Music Home Sense  HS Logo HS Loge
(B Recently Changed Loga Colog Gray
B searches
| Public
Did you find what you were searching for?
Advanced Search
Folders ~
[ 18items
Example Description

agenda AND report Finds files that contain both agenda and report.

agenda NOT report  Finds files that contain agenda, but not report.

agenda OR report  Finds files that contain either agenda or report.

“Agenda Report” Finds files that contain the exact phrase “Agenda
Report” in quotes.

(agenda report) Finds files that contain both words agenda and
report in any order.

date: >10/10/08 Find files that are later than 10/10/08.

size: < 100 MB Find files that are less than 100 MB.
subject: agenda Find files with the subject agenda and any files
AND report that contain the word report.
\- J




Performing Natural
Language Searches

Turn On Natural Language
Search

Click the Start button, and then
Control Panel.

Double-click the Folder Options
icon in Classic view.

Click the Search tab.

Select the Use natural language
search check box.

Click OK.

Perform a Natural Language
Search

Click in the Search box at the
bottom of the Start menu or at the
top of an Explorer window.

Type a natural language search.
Some examples include:

documents modified today
e-mail from holly sent this week
music by Mozart

videos of family created
December 2007

If using properties and boolean filters seems a little to much for you to

handle, you can find files using natural language search (New!),

which allows you to perform the same property or boolean search, yet

use a form that is easier to use. Instead of kind: document author:

(Steve AND Holly), you can type documents by Steve and Holly. Before

you can use natural language in a Search box, you need to turn it on

under the Search tab in Folder Options in the Control Panel.

Folder Options ==

[ General [ View | Search |

What to search

@) In indexed locations, search filenames and contents
In non4ndexed locations, search file names only.

(7 Aways search file names and corterts (might be slow)
() Aways search file names only

How to search
Include subfolders when typing in the Search box
Find partial matches
Use natural language search o
[ ] Don't uss the Index when ssarching the file system fight
be slow}

When searching nondndexed locations
[ Include system directories
[ Include compressed files (ZIP, CAB..)

Restore Defautts

o (e ] o

foErE

+ [ 42| [ documents modified today  mmmmmmmbimte

@Uv\ﬁa » Search Results in Indexed Locations

‘Shuwun\y E-msil  Document Picture Music  Other

Advanced Search(v- ‘

W Orgenize
SR Neme Date modified | Type Folder Authors  Tags
Organized
sy

[E| pocuments A=\ RTFFile
B Pictures =| 191bytes
B Music Did you find what you were searching for?
(5 Recently Changed Advanced Search
B searches

Public
Folders &

/7 litem

4
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Adding Properties
and Tags to Files

Microsoft
Certified WINV-4.6.1,

Application | WINV-4.6.2
Specialist

Add or Modify Properties

Click the Start button, and then
click Documents.

Click the file you want to add or
modify properties.

In the Details pane, click the tag
you want to change, and then type
the new tag.

If the Details pane is not
available, right-click the file,
click Properties, click the
Details tab. When you're done,
click Apply.

To add more than one tag,
separate each entry with a
semicolon.

To rate a file using the rating
property, click the star that
represents the rating you want to
give the file.

Click Save.

76

When you create a file, Windows automatically adds properties to the
files, such as name, creation date, modified date, and size. These prop-
erties are important to Windows, however, they may not be useful
when you are searching for a file. You can add or modify common files
properties and create or modify custom tag properties (New!) to make
it faster and easier to locate files in the future. You can add or modify
properties for most files. However, there are some exceptions, such as
plain text (.txt) or rich text format (.rtf) files. You can add or modify prop-
erties using the Details pane in an Explorer window, the Details tab in
the Properties dialog box, or in the Save As dialog box. If you want to
remove some or all of the property information in a file, you can quickly
remove it using the Properties dialog box.

e
(. )=[ i « Documents » pusiness » Photographs » Tracy Teyler v [ [ searcn A
) grapl oy Tey 4

~ M SlideShow et Print M8 E-mail [ Share

Views ~ |g@ Preview

Favorite Links
[E| Documents
B Pictures
B Music

3 Recently Changed

IB Searches Bench BirdHouse BirdHousel BirdHouse3 Flowers

I

=

{ < B

Folders o Home KidsStatue OrangeFlower Pond PurpleFlower i

S| Bench Date taken: 2/5/20053:08 AM Dimensions: 2272 x 1704
IPEG Image Tags|Garden; Jodd a tag Size: 251 MB
]

00 o




Add or Modify Properties While
Saving a File o

Click the File menu in the program @] sve he =]
you are USing, and then click OO [0 « Users » Steve » Documents » ~ [ 43 ][ search P
Save As. File name:  Year End e | .
Save as type |Waord Document -
Type tags and other properties in s sere TegslAgends; Add a9 1 o
the boxes provides. L et
~ Browse Folders Tooks + [ Sae |

To add more than one property,
separate each entry with a

semicolon. e

Type the name of the file.

Click Save.

Remove Properties

Click the Start button, click e
Documents, and then locate the

L . e
file in which you want to remove @)=[E » stcwe » Documens » 2] scort 5]
propertles. Wy Organize ~ 38 Views ~ [ Open ~ im Print M8 E-mail [ Share
New Folder Daterfodified  Type Size Tags
Select the file you want to remove 1 Eﬁl b I
- = Copy =i F I
propertles. Paste Year End Projects Home Sense
Undo
Click the Organize button on the =
toolbar, and then click Remove O toyou .
Properties. Folder and Search Options
75 Delete
. - Rename
Click the Create a copy with all e o
possible properties removed il
Close

option or click the Remove the
following properties from this file:
option.

Remove Properties

Folders -~ Some of these properties may contain personal information

Year End i AT {fiiat personal information mahtbe n & ek

Microsoft Office Word Document Authors: Steve © Create a copy with o possble properties removed |
Size: 965 KB 7 Remove the following properties from this file: I

Select or clear the check boxes
for each property.

Property Value =
Description
1 [T Title g
Click OK. Al b
[ Tags Agenda 7

[ Categories
[ comments
Grigin

&
Lastsavedby  Steve

[] Revision number 2

] Version number

seen e N
Select All
o
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Modifying the Index
to Improve Searches

Micr'o_soft
Certified WINV-4.4.1

Application
Specialist

View, Add, or Remove Indexed
Locations

Click the Start button, and then
click Control Panel.

Double-click the Indexing Options
icon.

TIMESAVER After a search,
click Search Tools on the toolbar,
and then click Modify Index
Locations.

Click Modify.

If you don't see all the locations,
click Show all locations.

If a folder location contains
subfolders, you can double-click
the folder to expand it.

Select or clear the check box next
to the folder locations you want to
add or remove from the index.

Click OK.
Click Close.

You can index file attributes for a
folder. Right-click the folder, click
Properties, click the General tab, click
Advanced, select the Index this file for
fast searching check box, and then
click OK twice.

18

Windows keeps track of files in indexed locations (New!) and stores
information about them in the background using an index, like the one
found in the back of this book, to make locating files faster and easier.
You can use Indexing Options in the Control Panel to view, add, remove,
and modify indexed locations, indexed file types, and other advanced
index settings. For example, if a file type is not recognized by the index,
you can add it, or if you're having problems with the search index, you
can rebuild or restore it.

/2 Indexing Options. =

1,254 items indexed

O
= Indexing complete,

Index these locations:

Included Locations Exdude
[ Microsoft Office Outiook
£ Offine Files

Start Menu

. Users Default
P _o
[ Advanced

Indexed Locations ==

Change sefected locations

[) 4 = Local Disk (C:) [=
> Documents and Settings

epson
MSQCache
Program Files
ProgramData
PSFONTS
b Ju WINDOWS
&, Local Disk (£
£ Offiine Files (Steve-PC\Steve)
> am REMovable Disk (G:)

m

OOOEEEDOREE

Summary of selected locations

Included Locations Exclude
Documents and Settings
epson
MSOCache
[Zpersonal folders (Steve-PCY,..
PSFONTS
Start Menu
Users Default
WINDOWS

|

o o




Set Advanced Indexing Options

Click the Start button, and then o
click Control Panel.

Advanchd Options. ==

Index Settings |p‘|E Types

Double-click the Indexing Options o
. fosttngs
Icon. [ Index encrypted fles —I

(] Treat similar words with diacritics as different words I

Click Advanced.

Troubleshooting

Re-index selected locations
Click the Index Settings tab. (O —— o
Select or clear the following check e ocaton
boxes: Current location:

E:\ProgramData\Microsoft
New location, after service is restarted:

Index encrypted files.

Select new o
Treat similar words with advanced ndesing hep
diacritics as different words.
For index troubleshooting, use
either of these buttons:
To re-index selected locations,
click Rebuild. E
To restore your index to its
original settings, click Restore prm—r -
Defaults. I Setinga] Fe Types |
Extension Filter Description e
If you need to change the Index e e
. . . Null filter
Location, specify a new location or 0 Fie repertes fter
. B Lee Pl filter
click Select new. oy e rapertesfer
= Nl filter o
: . Microsoft Office Filter
Click the File Types tab. e =
Plain Text filter i
Null filter
Select or clear the check boxes Mt
. . Plain Text filter i
Wlth the flle types y-OU Wa_nt tO How should this ﬁ\ehemd‘ex;c}l’. =
include or exclude in the index. (© tndex Propertes iy
(@ Index Properties and File Contents
For each selected file type, click et
the option _to specify how the file
should be indexed. I
Click OK. @
Click Close.

Chapter 3  Managing Files and Folders 79



Creating and
Renaming Files
and Folders

Microsoft
Certified WINV-4.2.1, WINV-4.2.2,

Application | WINV-4.6.3
Specialist

Create a Folder

Open the drive or folder where you
want to create a folder.

Click the Organize button on the

toolbar, and then click New Folder.

TIMESAVER Right-click a
blank area of the window, and
then click New Folder.

With the New Folder name
selected, type a new name.

Press Enter.

File names can be up to 255
characters. You can use spaces and
underscores in names, but you can't
use the following characters: @ * : < >
| 7 “\or/. Remember the best way to
keep your files organized is with a
consistent naming convention.

80

The keys to organizing files and folders effectively within a hierarchy
are to store related items together and to name folders informatively.
Creating a new folder can help you organize and keep track of files and
other folders. In order to create a folder, you select the location where
you want the new folder, create the folder, and then lastly, name the
folder. You should name each folder meaningfully so that just by read-
ing the folder's name you know its contents. After you name a folder or
file, you can rename it at any time.

Favorite Links

[E| Documents ‘ E b | l J

B Pictures 15 I |

B Music Business  YearEnd  Projects  HomeSense o
@ Recently Changed

BB searches

Public

Folders ~

New Folder
File Folder
Date modified: 11/28/2006 4:37 AM




Rename a File or Folder
Click the file or folder to select it.

Click the Organize button on the
toolbar, and then click Rename.

With the name selected, type a
new name, or click to position the
insertion point, and then edit the
name.

Press Enter.

TIMESAVER Right-click the file
or folder you want to rename, click
Rename, type a name, and then
press Enter. You can also select
the file, click the file name, type a
name, and then press Enter.

You can rename a group of files.
Select all the files you want to rename,
right-click one of the selected files,
click Rename from the shortcut menu,
type a name, and then press Enter. The
group name appears with numbers in
consecutive order.

|E=8EoR(~x7)|
@@-\E » Steve » Documents » ~ [ 42 |[ search El
~ M Open & E-mail [y Share
New Folder Date madif.. Type Size Tags
& | Cut

& Copy

Undo

Redo
Select Al

I Layout »
Folder and Search Options

< Delete

Rename

Remove Properties

Properties

Close

Folders ~

File Folder
Date medified: 11/28/2006 4:37 AM

] Budget

@@-\E » Steve » Documents » <[4 ][ search ol

Favortic Links Name Date modif.. Type size Tags

o' I

IE) Documents Il

B Pictures ﬂ).

B Music Business  VearEnd Projects  Home Sense | Financel o

(B Recently Changed
IB Searches
§ Public

Folders ~

Budget
File Folder
Date modified: 11/28/2006 4:37 AM
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Copying and Moving
Files and Folders

Micr_o_soft
Certified WINV-4.6.3

Application
Specialist

Copy a File or Folder

Open the drive or folder containing
the file or folder you want to copy.

Select the files or folders you want

to copy.

Click the Organize button on the
toolbar, and then click Copy.

Display the destination folder
where you want to copy the files
or folder.

Click the Organize button on the
toolbar, and then click Paste.

You can arrange files and folders in an
Explorer window by using Auto
Arrange or Align to Grid. The Auto
Arrange option keeps icons in a win-
dow organized so they don't overlap
each other, while the Align to Grid
option aligns icons in a window
according an invisible grid to keep
them organized. To turn either of these
options on, click the View menu in
folder you want to modify, and then
click Auto Arrange or Align to Grid. To
display the menu bar, click Organize on
the toolbar, point to Layout, and then
click Menu Bar.
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Sometimes you will need to move a file from one folder to another, or
copy a file from one folder to another, leaving the file in the first loca-
tion and placing a copy of it in the second. You can move or copy a file
or folder using a variety of methods. If the file or folder and the location
where you want to move it are visible in a window or on the desktop,
you can simply drag the item from one location to the other. Moving a
file or folder on the same disk relocates it whereas dragging it from one
disk to another copies it so that it appears in both locations. When the
destination folder or drive is not visible, you can use the Cut (to move),
Copy, and Paste commands on the Edit menu to move or copy the
items.

(E=3Eol =<7
@uv\ » Steve|» Documents b Home Sense » + [ 42| [ search el
New Folder Date modi.. Type Size Tags
& cut AP A= 4D A=
2| Copy e ] il & = = = =
] Paste Projects  Vendors  HSlogo  Customer  Festured  Organized  Safety
o Color Survey Books
Redo
Select All ' e
O Layout , | Finance
Folder and Search Options
X Delete
Rename
Remove Properties
Properties
Close

Finance
File Folder
Dste modified: 11/28/2006 4:37 AM

/ )\
For Your Information

Sending Files and Folders

When you right-click most objects on the desktop or in Computer or
Windows Explorer, the Send To command, located on the shortcut
menu, lets you send, or move, a file or folder to a new location on
your computer. For example, you can send a file or folder to a remov-
able disk to make a quick backup copy of the file or folder, to a mail
recipient as an electronic message, or to the desktop to create a
shortcut. You can also use the Send To command to move a file or
folder from one folder to another. To send a file or folder, right-click
the file or folder you want to send, point to Send To on the shortcut

menu, and then click the destination you want.
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Move a File or Folder

Open the drive or folder containing e
the file or folder you want to move. —
) ) )=[E v seve » [Documents » - [ 43 |[ searcn £l
Select the files or folders you want o ———
to move. New Folder Date modif... | Type:
& cut j b |

CIICk the Organize button on the |:|; ::Z ‘(Earjd Prrmens Hw;js%a F\ane o
toolbar, and then click Cut. Undo

Redo
Display the destination folder . —

n Layout »

where you want to move the files Folderand Serch Optirs
or folder. X velete

Rename

) . Remove Properties

Click the Organize button on the Propenis
toolbar, and then click Paste. s

Felders ~
Finance
File Folder
Date modified: 11/28/2006 4:37 AM

Copy or Move a File or Folder

Using Drag and Drop 0 0

0per_1 the drive or folder containing —
the file or folder you want to copy &[T+ [see » Docsmenis » < b2 |[ eare 5]
or move. ~ [ Bplore m/E-mal [ Share =

Favorite Links Name size Tags
Select the files or folders you want iy I b i
to COpy or move. B Music Bizes: (iSRSl VemEnd  Projects  HomeSense

(@ Recently Chanped

. o a BB searches
Click the Folders link in the pubic
Navigation pane. Foldas -
esktol e
. ; 4[5 sm:

Click the arrows to display the goo=
destination folder, and then click g |l
the destination folder. ey | e
Right-click the selected files or oo
folders, drag to the destination i
folder, and then click Copy Here or " fnance
Move Here. | F‘IEFD;chcliﬁzdz 11/28/2006 4:37 AM

TIMESAVER To move the
selected items, drag them to the
destination folder. To copy the
items, hold down the Ctrl key
while you drag.
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Deleting and
Restoring Files
and Folders

WINV-4.6.3

Delete Files and Folders

84

Select the files and folders you
want to delete.

Click the Organize button on the
toolbar, and then click Delete.

TIMESAVER Press the Delete
key to delete selected items.

Click Yes to confirm the deletion
and place the items in the Recycle
Bin.

On the desktop, right-click the
Recycle Bin icon, and then click
Empty Recycle Bin.

Your computer permanently
removes the items.

When you organize the contents of a folder, disk, or the desktop, you
might find files and folders that you no longer need. You can delete
these items or remove them from the disk. If you delete a file or folder
from the desktop or from the hard disk, it goes into the Recycle Bin. The
Recycle Bin, located on your desktop, is a temporary storage area for
deleted files. The Recycle Bin stores all the items you delete from your
hard disk so that if you accidentally delete an item, you can remove it
from the Recycle Bin to restore it. Be aware that if you delete a file
from a removable disk, it is permanently deleted, not stored in the
Recycle Bin. The files in the Recycle Bin do occupy room on your com-
puter, so you need to empty it to free up space.
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Restore Files and Folders

Double-click the Recycle Bin icon
on the desktop.

Select the item or items you want
to restore.

Click the Restore this item or
Restore all items button on the
toolbar.

You can undo a deletion. If you acci-
dentally delete a file, click Organize,
and then click Undo Delete. Windows
remembers your last three actions.

You can't open a deleted folder and
restore selected items. \hen you've
deleted a folder, you have to restore
the entire folder.

fol=E=s
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Changing Recycle Bin Properties

You can adjust several Recycle Bin settings by using the Properties
option on the Recycle Bin shortcut menu. For example, if you want to
delete files immediately rather than place them in the Recycle Bin,
right-click the Recycle Bin, click Properties, and then select the Do
Not Move Files To The Recycle Bin check box. Also, if you find that
the Recycle Bin is full and cannot accept any more files, you can
increase the amount of disk space allotted to the Recycle Bin by
moving the Maximum size of Recycle Bin slider to the right. The
percentage shown represents how much space the contents of the
Recycle Bin takes on the drive.

(d N\
For Your Information
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Creating a Shortcut
to a File or Folder

Microsoft
Certified WINV-4.2.3

Application
Specialist

Create a Shortcut to a File
or Folder

Open the drive or folder containing
the file or folder in which you want
to create a shortcut.

Right-click the file or folder, and
then click Create Shortcut.

To change the shortcut’s name,
right-click the shortcut, click
Rename from the shortcut menu,
type a new name, and then press
Enter.

Drag the shortcut to the desired
location.

You can improve performance by
limiting desktop items. To improve
performance on your computer and
find files more easily, it's better to cre-
ate desktop shortcuts rather than store
files in the Documents folder.
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It could take you a while to access a file or folder buried several levels
down in a file hierarchy. To save some time, you can create shortcuts
to the items you use frequently. A shortcut is a link that you can place
in any location to gain instant access to a particular file, folder, or pro-
gram on your hard disk or on a network just by double-clicking. The
actual file, folder, or program remains stored in its original location, and
you place an icon representing the shortcut in a convenient location,
such as in a folder or on the desktop.

[E=8EoE =)

G~ sieve v vocumets » « 45| [Search 2]

Wy Organze ~
T Name Datemodified  Type size Tags

[El Documents | |
B Pictures Lf i

B Music Home Sense = »—{D

i@

25 h

RS
S

(B Recently Changed
B Searches
Public

Explore

Search...

Share...

@ Snagit »
Restore previous versions.
Send To »
Cut

Copy
Paste

Create Shortcut
Delete

Properties

Folders ~

5 Home Sense
| File Folder
i F Date modified: 11/28/2006 4:43 AM

/4 N\
For Your Information

Placing Shortcuts on the Start Menu and Taskbar

You can place shortcuts to frequently used files, folders, and pro-
grams on the Start menu or toolbar on the taskbar. To do this, simply
drag the shortcut file, folder, or program to the Start button, wait until
the Start menu opens, drag to the All Programs submenu, wait until
the submenu opens, and then drag the shortcut to the appropriate
place on the menu. You can also drag a shortcut to a toolbar on the
taskbar using the same method. When you release the mouse, the

item appears on the menu or toolbar.




=gy = If you want to hide files and folder for added privacy purposes, you can
Hldlng Flles and do it by setting two separate options: one to set the option to hide spe-
Folders cific files and folders, and the other to set a general folder option to
show or hide files and folders. If you set the option to hide specific files
Micgeot} and folders and the Show hidden files and folders option is set, the hid-
Application | WINV-4.13 den files and folder appear transparent. If the general option is set to
Sieciflef Do not show hidden files and folder, the hidden files and folder are
actually hidden. The only way to view them again is to set the general
option to Show hidden files and folders again. Anyone can show hidden
files and folders, so it shouldn’t be used for security purposes.

Show or Hide Hidden Files and

¥ Annual Budget Properties ==
Fo I d e rs General | Security | Details | Previous Versions
Right-click the file or folder you B o
want to hide or unhide, and then Type dfie:  MicrosoftOffce Viord Documert (doc)
c | | Ck Properties. Openswith: ([, Microsoft Office Word
Location: E\Users\Steve \Documents'\Business'\Documents.
Select or clear the Hidden check S 110KB (11269 )
b OX Size on disk:  12.0 KB (12.288 bytes)
Created: Friday, November 10, 2006, 12:13:03 AM
CIlC k OK Madfied Monday, October 23, 2006, 8:58:50 AM
Accessed: Friday. November 10, 2006. 12:13:03 AM
The files or folders appear Avses: [featery Yridien
transparent or hidden. | e
[ OIK | [ Concel ][ ooy |

Show or Hide Hidden Files and
Folders

Click the Start button, and then
click Control Panel.

Folder views

“You can apply the view isuch as Details or Icons) that
you are using for this folder to all folders of this type.

Double-click the Folder Options

icon. | o
Advanced settings:

Click the View tab. oo ‘

[C] Aways show menus
Display fiie icon on thumbnails

Click the Do not show hidden files © vy o mpivmwe
and folders or Show hidden files B A mraion e

ot show hidden files and folders |
ow hidden fles and folders |
e extensions for known il types

ide protected operating system files 2

To set the'current view to all
folders, click Apply to Folders.
]

Click OK. é

and folders option.
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Changing Folder
Options

Microsoft
Certified WINV-4.1.1, WINV-4.1.2,

Application | WINV-4.1.3
Specialist

Change the Way All
Folders Work

Click the Start button, and then
click Control Panel.

Double-click the Folder Options
icon.

Click the General tab.

Select a Tasks option to display
frequently used tasks or the
contents of the folder.

Select a Browse folders option to
display each folder in the same
window or its own window.

Select a Click items as follows
option to single-click or double-
click items.

Click OK.

You can restore all folder options to
default Windows settings. On the
General tab in the Folder Options dia-
log box, click Restore Defaults.

When you work with files and folders, Windows displays folder con-
tents in a standard way, known as the default. The default folder view
settings are as follows: Tiles view displays files and folders as icons;
common task links appear in the left pane; folders open in the same
window; and items open when you double-click them. Depending on
previous installation or users, your folder view settings might differ.
Instead of changing the folder view to your preferred view—Icons, List,
or Details—each time you open a folder, you can change the view per-
manently to the one you prefer. In addition to the defaults, you can
change options such as folder settings to show or hide file extensions
for known file types, show or hide hidden files and folders, show or
hide protected operating system files, and show pop-up descriptions of
folders and desktop items.

?

Folddr Options ==
General |View | Search

Tasks
=272] (@ Show preview and fiters |
=22 ©) Use Windows classic Mdenﬂ

Browse folders

® Open each folder in the same window |
==

* Open each foder in i own window _ |

Click items as follows

N © Single-click .
@) Double-cick to open an ftem fsingle-click to select)
Restors Defauls
How do | change folder aptions?

I

@



Change the Folder View

Click the Start button, and then ?
click Control Panel.

Folder Op!iud =
Double-click the Folder Options e
icon. e o ™
CI k h V' b Apply I-:IFC-\delr
ick the View tab. o
Advanced settings
. [C] Aways show menus -
To set the current view to all 2 ﬁ?;‘;&mnfﬂnmghna.‘s' . i
. [ S
folders, click Apply to Folders. e
s O
Select the check boxes for the & i i
options you want, and clear the Bl et g rs e P
check boxes for the ones you [7] Remember each folder's view settings -
don't. Some common options
include: bosh
Always show menus (New!). !

Hidden files and folders. Click
an option to show or hide them.

Hide extensions for known file

types. (4 } N\
For Your Information
Hide protected operating

(s"\’ls;&':")"'es (Recommended) Understanding File Extensions

The program Windows uses to open a document depends on a three-
Show encrypted our letter extension to the document's file name, called a file extension.
compressed NTFS files in color You might have never seen a document's file extension because your
(New!). system might be set up to hide it. The file extension for simple text

files is “.txt” (pronounced “dot t-x-t”), and many graphic files have the
extension “.bmp”. This means that the full name for a text file named
Memo is Memo.txt. If you double-click a document whose file name
Click OK. ends with the three-letter extension “.txt,” Windows automatically
opens the document with Notepad, a text-only editor. If you want to
display or change file extension settings, click the Start button, click
Control Panel, and then double-click the Folder Options icon. If you
want to display file extensions in dialog boxes and windows, click the
View tah, and then clear the Hide extensions for known file types
check box in the Advanced settings list box. If you want to change the
program Windows automatically starts with a given file extension,
click the Start button, point to All Programs, click Default Programs,
click Associate a file type or protocol with a program, select the file
type, and then click Change Program to see the list of the file exten-
sions Windows recognizes and the programs associated with each of
them, and make changes as appropriate.

- J

Show pop-up description for
folder and desktop items.

You can reset folder views to original
Windows settings. On the View tab in
the Folder Options dialog box, click
Reset Folders.
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Changing File and
Folder List Views

Microsoft

Certified WINV-4.5.2

Application
Specialist

Change File Details to List

Open the folder you want to
change.

Right-click a column title, and then
click More, or click the View
menu, and then click Choose
Details.

TIMESAVER Right-click a
column title in Details view, and
then click the detail you want to
show or hide.

Select the check boxes with the
details you want to include and
clear the ones you don't.

Click the Move Up or Move Down
buttons to change the order of the
selected items.

Click the Show or Hide button to
show or hide the selected items.

Specify the width in pixels of the
column for the selected items.

Click OK.

An ellipsis indicates information is
hidden. To show the information, drag
the edge of the column indicator
button to resize the column.
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You can display files and folders in a variety of different ways, depend-
ing on what you want to see and do. When you view files and folders in
Details view, a default list of file and folder information appears, which
consists of Name, Size, Type, and Date Modified. If the default list of file
and folder details doesn't provide you with the information you need,
you can add and remove any file and folder information from the Details
view. If you need to change the way Windows sorts your files and fold-
ers, you can use the column indicator buttons in the right pane of
Details view. Clicking one of the column indicator buttons, such as
Name, Size, Type, or Date Modified, in Details view sorts the files and
folders by the type of information listed in the column.
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Customizing
Personal Folders

WINV-4.2.6,
WINV-4.5.1

Change the Folder Look

Open the folder you want to
change.

Click the Organize button on the
toolbar, and the click Properties.

Click the Customize tab.

Click the list arrow, and then
select the type of folder you want:
All Items, Documents, Pictures
and Videos, Music Details, or
Music icons.

Select the Also apply this
template to all subfolders check
box to apply the option.

To select a picture for display on
the this folder icon, click Choose
File.

To restore the default picture for
the this folder, click Restore
Default.

Click OK.

See Also

See “Customizing the Taskbar” on
page 118 for information on modifying
the taskbar.

In your personal folders, you can create your own folders and
customize view options based on the contents. In the toolbar of the
Pictures and Music folders, Windows provides buttons with file
management activities specifically related to the contents of the folder,
such as Slide Show in the Pictures folder, or Play All in the Music
folders. When you create a new folder, you can customize it for
pictures, music, and videos by applying a folder template, which is a
collection of folder task links and viewing options. When you apply a
template to a folder, you apply specific features to the folder, such as
specialized task links and viewing options for working with pictures,
music, and videos.

& | Pictures Properties ==l
[ General | Sharing | Secfity
Locaion |  Previous Versions | Customize

What kind of folder do you want?

Use this folder type as a template:

[ Pictures and Videas - o

L] Also apply this template to all subfolders

Folder pictures

Choose  file to show on this folder icon
Choose Fie... o
Restors Default

1

00
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Sharing Folders or
Files with Others

Microsoft
Certified WINV-4.3.1,

Application | WINV-4.3.2
Specialist

Share a File or Folders from the
Public Folder

Open the drive or folder containing
the files or folders you want to
share.

Select the files or folders you want
to share.

Click the Folders link to display the
Folders list.

Click the arrow next to the Public
folder to display the Public
subfolders.

Drag the selected items onto the
Public folder or subfolder where
you want to share files.

See Also

See “Setting Network Sharing
Options” on page 374 for information
on controlling access to a public folder
over a network.
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Windows Vista maintains a set of personal folders and options for
everyone on your computer to make sure the contents of each user’s
personal folders remain private. The contents of your personal folders
are private, unless you decide to share the contents with others who
use your computer. If you want the other users on your computer to
have access to files, you can place those files in a shared folder called
the Public folder (New!) that each user can access. The Public folder
contains subfolders to help you organize the files you are sharing, and
include Documents, Downloads, Music, Pictures and Videos. If you're
connected to a network, the files in the public folder are available to
network users. You can also share files from any folder on your com-
puter that you want to designate as a shared folder. When you specify
a shared folder, you can also set access permission levels for a person
or group.
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Share Any Folder on Your
Computer

Open the drive or folder containing
the files or folders you want to
share.

Select the folders you want to
share.

Click the Share button on the
toolbar.

Do any of the following:

Type the name of the person
with whom you want to share
files, and then click Add.

Click the arrow to the right of
the text box, click the person’s
name, and then click Add.

Click the arrow to the right of
the text box, and then click
Create a new user to create a
new user account.

Click the arrow next to the
permission level for the person or
group, and then select a sharing
permission:

Reader. Allows viewing only.

Contributor. Allows viewing and
adding files, and changing or
deleting files they add.

Co-owner. Allows viewing,
adding, changing, and deleting
all files.

Remove. Deletes the current
permission setting.

Click Share, and the wait while
Windows sets up sharing.

If you want, click the e-mail or
copy link to notify people you have
shared this folder and files.

Otherwise, click Done.
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You can compress files in special folders that use compressing soft-
ware to decrease the size of the files they contain. Compressed folders
are useful for reducing the file size of one or more large files, thus free-
ing disk space and reducing the time it takes to transfer files to another
computer over the Internet or network. A compressed folder is denoted
by a zippered folder icon. You can compress one or more files in a com-
pressed folder by simply dragging them onto the compressed folder
icon. When a file is compressed, a copy is used in the compression,
and the original remains intact. You can uncompress, or extract, a file
from the compressed folder and open it as you normally would, or you
can open a file directly from the compressed folder by double-clicking
the Compressed File icon. When you open a file directly, Windows
extracts the file when it opens and compresses it again when it closes.

Compressing Files
and Folders

Compress Files and Folders

Select the files and folders you o
want to copy to a compressed —
folder. @@vﬂﬁ » Steve » Documents b ~ 43 || search ol
) ) Wy Organize = BR Views e Share
Right-click one of the selected — o — o —— e
items, point to Send To, and then I Documens i 7 @ 4
click Compressed (Zipped) Folder. g e oot NS e
@ Recently Changed i:::
If you want, rename the Wi r—
compressed folder. | e
. . Send To » | |1, Compressed (zipped) Folder
To copy additional files or folders — B o
to the compressed folder, drag the corr i
files onto the compressed folder. B vouse2r)
CraSwimi o= Removable Disk (G)
Delete
Rename
Folders A
3 Home Sense Date modified: 11/28/2006 4:2 J'AMp =
£ F File Folder Shared with: Steve-PC\Holly
You can also compress file attributes
in a folder. Right-click the folder, click
Properties, click the General tab, click ol E%‘
v | ¥+ || Search

Advanced, select the Compress con-
tents to save disk space check box,
and then click OK twice.

94

@@vlﬂ:\ » Steve » Documents »

BE =~ {J'Open M Email By Share

Favorite Links Name Date modified  Type

=
I Decuments

Tags

B Pictures [t i f f
B Music Business  HomeSense HomeSense  YearEnd Projects
(& Recently Changed
B searches

Public
Folders A~

J Home Sense Date modified] 11/28/2006 5:06 AM

Compressed (zipped) Folder Size{99.0 KB
I Date created]11/28/2006 5:06 AM

Compressed folder o



View Compressed Files

Double-click the compressed
folder to open it.

Double-click an item in the folder
to open it using its associated
program.

Decompress Files

Double-click the compressed
folder to open it.

Select the files you want to
decompress.

Do one of the following:

Single file or folder. Double-
click the compressed folder to
open it, and then drag the file
or folder from the compressed
folder to a new location.

All files. Right-click the
compressed folder, and then
click Extract All, and then step
through the Extraction Wizard.
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Managing Files
Using a CD or DVD

Microsoft
Cor{fipd WINV-4.6.4

Application
Speciali

Burn a Disc Using the Mastered

Format

96

Insert a writeable CD or DVD into
your CD or DVD recorder.

Click Burn files to disc.
Type a name for the disc.

Click Show/Hide formatting
options.

Click the Mastered option.
Click Next to continue.

Open the folder that contains the
files you want to burn, and then
drag the files onto the empty disc
folder.

Click Burn to disc on the toolbar.

The selected files are copied to
the disc. The disc recorder tray

opens when the disc is complete.

The low cost and large storage size of discs, either CD or DVD (New!),
makes creating and using CDs or DVDs an effective way to back up
information or transfer large amounts of information to another com-
puter without a network. Before you can create a CD or DVD, you must
have a blank writeable CD or DVD and a recorder (also known as a
writer or burner) installed on your computer. You can copy, or write,
files and folders to either a writeable disc (CD-R or DVD-R) or a rewrite-
able disc (CD-RW or DVD-RW). With writeable discs, you can read and
write files and folders many times, but you can’t erase them. With
rewriteable discs, you can read, write, and erase files and folders many
times, just like a hard disk. When you burn a disc, Windows needs disk
space on your hard disk equal to the capacity of the disc. For a typical
CD, this is between 650 and 740 megabytes (MB) and for a DVD, this is
about 4.7 gigabytes (GB). Do not copy more files and folders to the CD
or DVD than it will hold; anything beyond the limit will not copy. With
Windows Vista, you can burn a disc using one of two formats: Live File
System or Mastered. The Live File System (New!) format allows you to
copy files to a disc at any time, like a USB drive, while the Mastered
format needs to copy them all at once. If you need a disc for Windows
XP or later and want the convenience of copying files at any time, the
Live File System is the best choice. When you need a compatible disc
for older computers, the Mastered format is the better choice.

aw AutoPlay [ & ==

DVD RW Drive (E3)

[7] &hways do this for blank DVDs:

Blank DVD options

- 5urn fles to disc
¥ s

Set AutePlay defaults in Centrol Panel

Burn a Disc ==
Prepare this blank disc

Disctitles  Backup

@ Live File System - Allows you te add and erase files, like a USE
flash drive. Might not be readable on opersting systems before
Windows XP.

Chenge version

@ Mastered - Readable on all computers and some CD/DVD
players. Requires you te wite all files ot once, and individual
files can't be erased afterwards

Which CD or DVD format should I choose?

o o

(a) Hide formatting options




Burn a Disc Using the Live
System Format (3]

Insert a writeable CD or DVD into

Burn a Disc ==
your CD or DVD recorder.

Prepare this blank disc

Disctitle; | Backup el

Click Burn files to disc.

@ Live File System - Allows you to add and erase files, like 2 USB
flash drive. Might not be readable en operating systems before
H W XP.
Type a name for the disc.

Change version

(© Mastered - Readable on all computers and some CD/DVD
players. Requires you to write all iles at once, and individual
files can't be erased afternards.

Click Show/Hide formatting
options.

Which CD or DVD format should I choose?

Click the Live File System option,
click Change version, and then
select the version you want.

Click Next to continue.

(~) Hide formatting options

Windows names, formats, and
prepares the disc for use.

—
@u-\;l,i b EmeE

File Edit View Tools Help
W Organize

Upon completion, open the folder
with the files you want to burn.

ws v M AutoPlay e Eject o Properties §32] System properties 5

Favorite Links Total Size  Free Space

Drag the files into the disc folder.

[E Documents

B Pictures - VSTAD) ‘
As you drag files into the disc B e w::z:;:;m 285 68 rec of 541 6B .
folder, they are Copied Folders ~ | g VDN D= By Bacp
automatically to the disc. i || e .

o P

To close the session and prepare pregromies| || L@ open sutoPia
the disc for use, press the Eject & u;:zim e o
button on your disc drive or right- B Corcs o

click the writeable drive, and then

click Close session.

After you close a session, you can
still add files to the disc. However,

you need to close the session.

W Desktop
I Document .

; J) DVORwWDrive ) B
-~

V5o

Eject
Copy

Create Shortcut.

Properties

I JFile system: UDF

1item selected

M Computer I

(4 - ) ) N\
Live File System Versions
You can erase some or_all of thf_z files Version  Compatible with
on a disc. Insert the writeable disc
with the Live File System format, click 1.02 Windows 98 and many Apple Computers; also works if you
the Start button, click Computer, click need to format DVD-RAM or MO (Magneto-optical) discs
the writeable drive, and then click 15 Windows 2000, Windows XP, and Windows Server 2003
Erase this disc on the toolbar to erase - -
all the files. Double-click the writeable 201 Windows XP and Windows Sarver 2003
drive, select the files you want to 25 The latest version of Windows; Windows Vista
delete, and then press Delete. J
Chapter 3  Managing Files and Folders 97






